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Introduction

A typical retail operation has two components: the shopfront operation and the back office. The
shopfront operation handles day‐to‐day retailing tasks, such as recording sales and ordering stock,
while the back office handles general business tasks, such as bookkeeping, paying wages and bills, and
reporting GST [New Zealand] or Business Activity Statement (BAS) amounts [Australia].
Your MYOB retail business solution consists of two software components that have been designed to
handle the unique needs of each operational area:


MYOB RetailManager is designed to manage your shopfront



MYOB business management software (such as MYOB AccountRight) is designed to manage your
back office.

Although each component runs independently, accounting information recorded in your shopfront
(such as sales income and GST collected) is needed to complete your back office tasks (such as
reporting profit and preparing your BAS). The process of consolidating your shopfront accounting
information with your back office accounting information is called accounting integration.
To complete the accounting integration process, you take information from RetailManager (this task is
known as exporting) and integrate it with your business management software information (this task is
known as importing).

Accounting integration overview
Although RetailManager and MYOB business management software are designed to run
independently, they share many business management and retail features. For example, you can
record sales and send statements using either RetailManager or your business management software.
Although you can use either software component to perform many similar tasks, to get the most out of
your MYOB retail business solution, we recommend using the specialist features from each
component.
As part of the accounting integration process, you need to decide on the features that you will use in
each component. You also need to decide how often you will integrate your accounting information.
For example, you may want to integrate your accounting information on a daily basis so that you can
keep information in your business management software—such as your bank account
details—up‐to‐date.
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The following table provides an example of the retail and business tasks that you can perform on a
daily, weekly, monthly and yearly basis and the software component you should use to perform them.
Frequency

In RetailManager

In your business management software

Daily

Record customer information

Import your shopfront accounting information
into your business management software

Record sales and track serial numbers
Print dockets and email transactions, such as
invoices and purchase orders
Cash up and print cashup reports and sales
reports
Export your shopfront accounting
information from RetailManager
Weekly or
monthly

Print what’s selling and profit reports

Reconcile bank accounts, track petty cash
transactions, make electronic payments and
import bank statements

Record supplier information and print
supplier reports

Pay bills and record and settle supplier debits

Print stock reports and prepare purchase
orders

Pay employees, make superannuation
contributions, report and pay payroll tax

Receive goods into stock, create stock
records, classify stock and print stock bar
code labels

Prepare and lodge your BAS

Send customer statements
Send promotional material to customer
contact groups
Print staff profit reports
Yearly

Perform a stocktake

Prepare budgets, financial reports (such as
profit and loss and balance sheet reports) and
provide information to your accountant

Make bulk price adjustments for the annual
sale

Enter end‐of‐year adjustments
Start a new financial year and start a new
payroll year

ACCOUNTING INTEGRATION OVERVIEW
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Setting up for
integration

This chapter describes the setup tasks that you need to complete in RetailManager and in your
business management software before you can integrate your accounting information.

Overview
There are two types of setup tasks that you need to complete—general setup tasks and setup tasks
specific to the accounting integration process. Before you can complete the accounting integration
setup tasks, you need to complete the general setup tasks.

General setup tasks
In RetailManager:
Task

See

1

Install RetailManager

your RetailManager Getting Started guide

2

Create a shopfront

the ‘Setting up’ chapter in your
RetailManager User Guide

3

Set your regional settings

the ‘Setting up’ chapter in your
RetailManager User Guide

NOTE :
If RetailManager and your business
management software are installed on
different computers, you need to set the date
format on each computer to dd/MM/yyyy.

4

Create staff and customer records

the ‘Staff’ and the ‘Customers’ chapter in your
RetailManager User Guide

5

Create supplier and stock records

the ‘Stock Management’ chapter in your
RetailManager User Guide

5

In your business management software:
Task

See

1

Install your business management software

your business management software Getting
Started guide

2

Create and activate your company file

the ‘Setting up your company file’ chapter in
your User Guide

3

Set up your company file

the ‘Setting up your company file’ and the
‘Advanced setup’ chapter in your User Guide

NOTE :

The amount of information that
you enter depends on your individual
business requirements.

When you have completed the general setup tasks, you then need to set up your software for the
accounting integration.

Setup tasks specific to the accounting
integration
Task

See

1

Set up accounting options in RetailManager

‘Task 1: Set up accounting options in RetailManager’ on
page 7

2

Set up tax codes in RetailManager and in your
business management software

‘Task 2: Set up tax codes’ on page 13

3

Set up supplier information in RetailManager
and in your business management software

‘Task 3: Set up supplier information’ on page 15

4

Set an import preference in your business
management software
Note that this task is not required if you use
the AccountRight Online API to link your
software.

‘Task 4: Set an import preference in your business
management software’ on page 16

SETUP TASKS SPECIFIC TO THE ACCOUNTING INTEGRATION
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Task 1: Set up accounting options in RetailManager
In RetailManager, you use the accounting export feature to export your shopfront accounting
information. To use this feature, you need to set up your accounting options. When you do this, you
specify the type of information you want to export, the export method you want to use and where you
want to save the export file. You also specify the account numbers that you want to post your
RetailManager journal entries to. You can also set up export groups and use these groups to ensure
that certain payment types are allocated to a specific bank account.
AccountRight Online API configuration If you’re using AccountRight and you store your company file
online, you can use the AccountRight Online API to connect your RetailManager file and your
AccountRight company file. All you need to do is select the AccountRight Online API Package and then
configure some settings to get both programs to talk to each other.

To set up accounting options in RetailManager
1

Go to the Setup menu and choose Options. The Options window appears.

2

Click Accounting. The Export tab appears.

SETUP TASKS SPECIFIC TO THE ACCOUNTING INTEGRATION
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Section

Task

Package

Specify the business management software package that you are using. Note that the
options that appear in the Export tab vary according to the package that you select.

Path

Specify the folder where you want to save the export file. Click Browse and select the
location in the Browse For Folder window.
If you want to be prompted to import the export file when you start your business
management software, you should specify your business management software folder
(for example, C:\Premier19).
NOTE :

AccountRight Online API If you’re using the AccountRight Online API,
the path is selected for you. As your retail data is sent directly to your
AccountRight file, no export file is created or imported. However, if an error
occurs when sending data, you’ll find details of the error in a log file located in this
folder.
Information to
Export

Select the type of information you want to export:
• Suppliers—new supplier records
• Purchases—Goods Received transactions
• Journal Entries—a summary of the day’s trading information, including sales, sales
orders, inventory adjustments, cash drawer shortages and GST information.

Exporting Method

Select the accounting method that you want to use to export amounts. If you are unsure
about which method to use, consult your accountant.

Tax Code (if none
assigned)

Select a default tax code. To import your accounting information into your business
management software a tax code must be assigned to each line in the journal entry. The
tax code that you select will be assigned to each line in the journal entry that does not
have a tax code assigned. We recommend that you select the N‐T (No Tax) tax code. In
this way, your tax collected accounts will not be affected.

Job Number

If required, specify a job number. A job number is used to identify RetailManager
journal entries in your business management software. You may want to specify a job
number if you have multiple stores and you export your accounting information from
each store to a central office to perform the accounting integration. If you specify a job
number, you can use the job number to identify each store’s accounting information.

SETUP TASKS SPECIFIC TO THE ACCOUNTING INTEGRATION
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Section

Task

Export Detailed
Journals

A clearing account is a temporary account containing individual transaction amounts
that are transferred in a batch to another account. The clearing account is debited and
credited and the balance of the account is always $0.
If you want to use a RetailManager clearing account, select the Use Clearing Account
option. When you select this option, your RetailManager transactions (except for cash
transactions) are exported as individual transactions. For example, if in a day you record
20 EFTPOS transactions and 100 cash transactions, when you perform the accounting
integration each EFTPOS transaction appears in your business management software as
an individual transaction. On the other hand, all cash transactions are totalled and
appear as one transaction (this is because you usually deposit cash into your bank
account in one lump sum payment). Using a clearing account makes it easier to
reconcile your bank accounts.

API Configuration

To configure your AccountRight Online API settings:
1

Select the AccountRight Online API package. The API Configuration section
appears.

2

Click Configure. A sign‐on window appears.

3

Enter the MYOB account details you use to sign‐in to your AccountRight company
file. (These are also known as your my.MYOB account details.)

4

Select your online company file.

5

Enter your AccountRight company file User Name and Password.

6

Click Test Connection to check that the details have been entered correctly.

When the connection test is successful, click OK.
Your RetailManager and AccountRight software are now talking. Any exports you make
from RetailManager will be sent directly to AccountRight and updated in your company
file.
7
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3

Click Apply and then click the Chart of Accounts tab.

4

In the Chart of Accounts tab, specify the account numbers that you use in your business
management software. Journal entries that you import into your business management software
are then posted to the account numbers that you specify.
NOTE :

Account numbers for sock items The sales income account and cost of goods account shown in
this tab are default accounts. You can set different income and cost of goods accounts for each stock item.

You should note the following when specifying account numbers:
 Account numbers in your business management software include a hyphen (for example, 4‐1100).
You must omit the hyphen when you enter the account numbers in RetailManager.
 Some of the accounts listed in the Chart of Accounts tab may not have a corresponding account
number in your business management software. If you need to use that account, create the
account in your business management software accounts list. For more information, see the
‘Setting up your company file’ chapter in your business management software User Guide. If you
don’t need that account (for example, if you do not record Gift Vouchers or Lay‐bys), then enter
00000 in the account field.
 The account numbers that you enter must correspond to detailed accounts. Do not enter account
numbers for header accounts. (Detail accounts are accounts that you can post transactions to.
Header accounts are accounts used to group similar detail accounts. You cannot post transactions
to a header account.)
 The account numbers that you enter must be active accounts. Do not enter an account number for
an inactive account. (An inactive account is an account that you have deactivated by selecting the
Inactive Account option in the Edit Accounts window in your MYOB business management
software.)
 [Australia only] The Pre‐Paid GST account field only appears if you selected the Accrual Exporting
Method in the Export tab.
 The RM Clearing Account field only appears if you selected the Use Clearing Account option in
the Export tab.

SETUP TASKS SPECIFIC TO THE ACCOUNTING INTEGRATION
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5

For more information about...

See...

the Chart of Accounts tab

the ‘Setting Up’ chapter in your MYOB RetailManager User
Guide

your business management software
accounts

the ‘Setting up your company file’ chapter in your business
management software User Guide

active or inactive accounts

the ‘Lists’ chapter in your business management software
User Guide

Click Apply and then click the Banking Export tab.

In this tab, you set up export groups to group together payment types. You do this to allocate
different payment types to the same bank account. For example, you may want your cash and
cheque payment types to be allocated to one bank account and your electronic payment
types—such as VISA and MasterCard—to be allocated to another bank account.
Note that you do not have to use export groups. If you deposit all takings into the same bank
account, then there is no need to set up export groups. In this case, all payment types are exported
to the bank account specified in the Bank Account field in the Chart of Accounts tab. If you don’t
want to create export groups, click OK and continue with ‘Task 2: Set up tax codes’ on page 13.
To create export groups
When you create export groups, you specify a name for the group and an account number from
your MYOB business management software. You then link the payment types (for example, cash
and cheque) to the export group. Note that you can create as many export groups as you need.
a In the Banking Export tab, click Create. The Export Group window appears.

b

In the Name field, type a name for the export group.

SETUP TASKS SPECIFIC TO THE ACCOUNTING INTEGRATION
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In the Account field, specify the relevant account number from your business management
software. Remember to omit the hyphen when you enter the account number.
d Click OK. The Banking Export tab reappears. The export group that you created appears in the
Payment Groups column.
c

e

In the Available Payment Types column, select a payment type and then click the arrow button
(
). The payment type appears in the Associated Payment Types column.

Repeat step e above for each payment type that you want to add to the export group.
If you want to remove a payment type, select the payment type in the Associated Payment
Types column and click the arrow button (
).
h Click Apply.
i If you want to create another export group, repeat from step a on page 11.
If you want to delete a payment group, select the group in the Payment Groups column and then,
click Delete.
f

g

6
7

When you have finished creating export groups, click OK. An information message appears.
Click OK. The Options window closes.
Continue with ‘Set up tax codes’ below.

SETUP TASKS SPECIFIC TO THE ACCOUNTING INTEGRATION
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Task 2: Set up tax codes
When you set up tax codes, you need to:


specify details for each tax code in RetailManager



check that each RetailManager tax code is entered in your business management software and
that the name and account number match. For more information about entering tax codes in your
business management software, see the ‘Lists’ chapter in your business management software
User Guide.

Before you begin You need the details of the tax codes in your business management software. Start
your business management software and go to the Lists menu and choose Tax Codes. The Tax Code List
window appears. If you want to print the tax code list, click Print.

To set up tax codes
NOTE :

Graphics in the following procedure show Australian tax codes. If you are using the New Zealand
version of RetailManager, the names of the tax codes will vary.
1

In RetailManager, go to the Admin menu and choose Set Tax Codes. The Tax Codes List window
appears.

2

Click a tax code. The Tax Code Information window appears.

3

In the Export Tax Code field, specify an export tax code. This code should match the code that
appears in your business management software.
 [Australia] This code is a 3‐character code, such as FRE or GST.

SETUP TASKS SPECIFIC TO THE ACCOUNTING INTEGRATION
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[New Zealand] This code is a single character code, such as S or E.
In RetailManager:

4

In your business management software:

In the A/C for tax on Sales field, specify an account to record tax collected from sales. Remember to
omit the hyphen when you enter the account number.
NOTE :

[Australia only] You only need to specify an account for tax on sales for Goods & Services Tax
codes and Sales Tax codes. You do not need to specify an account for tax on sales for Input Taxed codes.

The account that you specify in RetailManager should be the linked account for tax collected from
the corresponding tax code in your business management software.
In RetailManager:

In your business management software:

SETUP TASKS SPECIFIC TO THE ACCOUNTING INTEGRATION
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[Australia only] If you use Sales Tax codes, you need to create a liability account in your business
management software called ‘Sales Tax Collected’. Then, for each Sales Tax code, you need to
specify the ‘Sales Tax Collected’ account as the account for tax on sales.
In RetailManager:

In your business management software:

5

Click Commit ‐ F10. The Tax Codes List window appears.

6

Repeat from step 2 on page 13 for each tax code.

7

When you have finished setting up tax codes, close the Tax Codes List window.
Continue with ‘Task 3: Set up supplier information’ on page 15.

Task 3: Set up supplier information
You need to synchronise your RetailManager supplier list with your business management software
supplier list. When you do this, you check that supplier names in your RetailManager supplier list are
spelt the same as supplier names in your business management software. If a supplier name exists in
both your RetailManager supplier list and your business management software supplier list, but it is
spelt differently, an error message appears when you perform the accounting integration.
NOTE : Adding new suppliers to your business management software If you selected the Suppliers
option in the Export tab in ‘Task 1: Set up accounting options in RetailManager’ on page 7, new supplier
cards are automatically created in your business management software when you integrate your accounting
information. New supplier cards are only created if the supplier did not already exist in your business
management software.

Before you begin You need to refer to your business management software supplier list. In your
business management software, go to the Card File command centre and click Cards List. The Cards
List window appears. Click the Supplier tab. If you want to print the supplier list, click Print.

To set up supplier information
1

In RetailManager, go to the Information window and choose Suppliers. The Suppliers window
appears.

SETUP TASKS SPECIFIC TO THE ACCOUNTING INTEGRATION
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2

Click the search icon (

). The Search for Supplier No window appears.

3

Compare supplier names in RetailManager with supplier names in your business management
software. If required, change the names in either your RetailManager software or your business
management software so that they match. Note that you should match the case and the spacing.
 For more information about editing supplier records in RetailManager, see the ‘Stock
Management’ chapter in your RetailManager User Guide.
 For more information about editing supplier cards in your business management software, see
the ‘Lists’ chapter in your business management software User Guide.

4

When you have finished reviewing your supplier list and making any changes, continue with ‘Set an
import preference in your business management software’, on page 16.

Task 4: Set an import preference in your business
management software
NOTE :

Using the AccountRight Online API? If you’re using the AccountRight Online API, you don’t need to
complete this step. Your file is automatically set up to import from RetailManager.

You can set a preference in your business management software to automate the process of importing
your shopfront accounting information. With this preference set, you will be prompted to import any
new shopfront accounting information when you start your business management software.

However, before you are prompted to import your shopfront accounting information, you must have
exported your accounting information from RetailManager and saved the export file in your MYOB
business management software folder (for example, C:\Premier19). For more information about
saving the export file to this location, see ‘Task 1: Set up accounting options in RetailManager’ on
page 7.

SETUP TASKS SPECIFIC TO THE ACCOUNTING INTEGRATION
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To set the automatic import preference
1

Open your business management software.

2

Go to the Setup menu and choose Preferences. The Preferences window appears.

3

Click the System tab.

4

Select the I use MYOB RetailManager option.

5

Click OK.

SETUP TASKS SPECIFIC TO THE ACCOUNTING INTEGRATION
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3

Accounting
Integration

This chapter describes the accounting integration process. When you integrate your accounting
information, you export your shopfront accounting information from RetailManager and then import
this information into your business management software.
NOTE :

Troubleshooting the accounting integration Warning and error messages may appear during the
accounting integration. The Troubleshooting chapter of this guide lists the messages that may appear and the
solutions to fix these issues. For more information, see Chapter 4, Troubleshooting, on page 23.

Accounting integration process
There are two steps to the integration process:
Step

See

1

Export your shopfront accounting information from RetailManager

below

2

Import your shopfront accounting information into your business management
software

page 20

Task 1: Export your shopfront accounting information from
RetailManager
When you export your shopfront accounting information from RetailManager, your accounting
information is exported to a text file called Retail.txt. This file is saved to the location you specified in
the setup options (for more information, see page 7).
Your RetailManager tax code information is automatically exported and, depending on the options you
selected when setting up, the following information may also be exported:


new supplier records



Goods Received transactions and Returned Goods transactions (purchases and returns)



general journal entries.

Before you begin Before you export your shopfront accounting information from RetailManager,
you should end your current cashup session. For more information about cashing up, see the ‘Cashing
Up’ chapter in your RetailManager User Guide.
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To export your shopfront accounting information
NOTE :

Error messages
on page 23.
1

If an error message appears during the export, see ‘Error messages when exporting’

In RetailManager, go to the File menu and choose Accounting Export. The accounting export
window appears.

A
B
C

A

D

The name of your business management software package appears in the title bar.

B

The number of new suppliers to be exported appears in the Suppliers to be Exported field.

C

•
•
•
•

D

The number of new purchases or returns to be exported appears in the Purchases/Returns to be
Exported field.

The cash up session number and the till number appear in the Session No and Till columns.
The start and end date and time for each cash up session appear in the Opened and Closed columns.
The transaction number at the start and end of each session appear in the Start and End column.
The status of the session appears in the Comments column. The status can be:
Exported—the session has already been exported
Will be Exported—the session will be exported
Not reconciled—you have cashed up, but not recorded any takings.

2

Click Export. An information window appears.

3

Click OK. The export window reappears. The status of the cash up session changes to Exported.

4

Close the export window.

ACCOUNTING INTEGRATION PROCESS
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Task 2: Import your shopfront accounting information into
your business management software
To integrate your shopfront accounting information with your back office accounting information, you
need to import the information contained in the Retail.txt file into your business management
software. The Retail.txt file was created when you exported your accounting information in the
previous step.
NOTE :

Export backup file When you exported your shopfront accounting information from RetailManager,
two export files were created: Retail.txt and RMCopy.txt. The RMCopy.txt file is an exact copy of the Retail.txt
file and serves as a back up in case there is an issue with the Retail.txt file (for example, if the file is deleted or
corrupted). If you need to use the RMCopy.txt file for the import, see ‘Using the RMCopy.txt file for the
accounting integration’ on page 21.

Depending on the options you selected when setting up, the following information is imported:


new suppliers—supplier cards are added to your Cards List (supplier cards are only added if the
supplier does not already exist in your business management software)



Goods Received transactions and Returned Goods transactions (purchases and returns) are added
as Bill transactions (service type)



general journal entries are added to your transaction journal and amounts are posted to the
accounts you specified in the setup options.

Note also that your RetailManager tax codes are matched to your business management software tax
code list.
If you selected the I use MYOB RetailManager option in the Preferences window in your business
management software and if you specified to save the export file to your business management
software folder, you can automatically import your shopfront accounting information into your
business management software. For more information, see ‘To automatically import your shopfront
accounting information’ below.
If you did not select this option or if you saved the export file to a different location, you need to
manually import your accounting information into your business management software. For more
information, see ‘To manually import your shopfront accounting information’ on page 21.

To automatically import your shopfront accounting information
NOTE :

Warning and error messages If a warning or error message appears during the import, see ‘Error
and warning messages when importing’ on page 27.
1

Start your business management software. An information message appears.

ACCOUNTING INTEGRATION PROCESS
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2

Click Yes. The information in the Retail.txt file is integrated with your back office accounting
information. A confirmation message appears.

3

Click OK.

To manually import your shopfront accounting information
NOTE :

Warning and error messages If a warning or error message appears during the import, see ‘Error
and warning messages when importing’ on page 27.
1

Start your business management software.

2

Go to the File menu and choose Import Data, then choose RetailManager. The information in the
Retail.txt file is integrated with your back office accounting information. A confirmation message
appears.

3

Click OK.

Using the RMCopy.txt file for the accounting integration
If there is an issue with the Retail.txt file (for example, if the file is deleted or corrupted), you can use
the RMCopy.txt for the accounting integration. If you do this, you need to rename the Retail.txt file (if
it has not been deleted) to RetailOld.txt and then rename the RMCopy.txt file to Retail.txt file. You can
then use the Retail.txt file (previously the RMCopy.txt file) for the accounting integration.

ACCOUNTING INTEGRATION PROCESS
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To use the RMCopy.txt file for the accounting integration
1

Open Windows Explorer and locate the Retail.txt and the RMCopy.txt files. These files are saved to
the location you specified in the Path field in the Options window. For more information, see
‘Task 1: Set up accounting options in RetailManager’ on page 7.

If the Retail.txt file has been deleted from this location, go to step 3 below.
2

Rename the Retail.txt file to RetailOld.txt:
a Right‐click the Retail.txt file and choose Rename.
b Rename the file to RetailOld.txt.

3

Rename the RMCopy.txt file to Retail.txt:
a Right‐click the RMCopy.txt file and choose Rename.
b Rename the file to Retail.txt.

You can now import the Retail.txt file into your business management software. For more information,
see ‘Task 2: Import your shopfront accounting information into your business management software’
on page 20.

ACCOUNTING INTEGRATION PROCESS
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Troubleshooting

This chapter describes the warning and error messages that may appear when you perform the
accounting integration. It also describes the procedures you need to follow to fix the issues.
After integrating your shopfront accounting information, you may find that there is a discrepancy
between the value of your stock in RetailManager and the value of your stock in your business
management software. This discrepancy is called a ‘stock discrepancy’. This chapter also describes the
procedure you need to follow to fix this discrepancy.
For more information about...

See...

Error messages when exporting

below

Error and warning messages when importing

page 27

Resolving a stock value discrepancy

page 45

NOTE :

Fixing errors in AccountRight 2011 The process for fixing errors in AccountRight Plus 2011 and
AccountRight Standard 2011 is different to that outlined in this guide. Please refer to our support note for
information on how to fix import errors in these versions,. Go to (New Zealand) myobnz.custhelp.com or
(Australia) myob.com.au/supportnotes and search for ID 33722.

Error messages when exporting
When you export your shopfront accounting information from RetailManager, a number of error
messages may appear. Error messages appear when there is an issue with your shopfront database or
with the information you specified in the setup options.
If an error message appears during the export, you need to review the message, fix the issue and then
retry the export.
The table below lists the most common error messages. If an error message appears, but it is not listed
in the table, contact MYOB Technical Support (see ‘Technical Support’ on page 53).
Error message

See

Please check your tax code ‘xxx’ sales export account

page 24

Export directory “\\xxx\xxx\” does not exist. Please check your Accounting Export Options (found
under Setup‐Options)

page 24

Error occurred retrieving export directory in CExport:FileDir Bad File name or number

page 26

Error occurred exporting variance in CExport: JournalVariance

page 26
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Please check your tax code ‘xxx’ sales export account
You have not specified an account for tax on sales for one or more of your RetailManager tax codes.
1

Go to the Admin menu and choose Set Tax Codes. The Tax Codes List window appears.

2

Click a tax code. The Tax Code Information window appears.

3

In the A/C for tax on Sales field, enter an account for tax on sales. For more information, see ‘Set up
tax codes’ on page 13.

4

Click Commit ‐ F10. The Tax Codes List window reappears.

5

Repeat from step 2 above for each tax code.

6

When you have finished, close the Tax Codes List window.

7

Re‐export your accounting information. For more information, see ‘Re‐exporting your accounting
information’ on page 51.

Export directory “\\xxx\xxx\” does not exist. Please check your Accounting Export
Options (found under Setup-Options)
The folder that you specified to save the Retail.txt file to does not exist or is not in the location you
specified.
1

Go to the Setup menu and choose Options. The Options window appears.

2

Click Accounting. The Export tab appears.

3

Check the location you entered in the Path field. Ensure that the location exists and that you have
spelt the folder name correctly. If required, enter a new location.
NOTE :

If you have problems browsing to the location you want to enter, consult your Network
Administrator. For more information about the Export tab, see ‘Task 1: Set up accounting options in
RetailManager’ on page 7.
4

Click OK. A confirmation message appears.

5

Click OK. The Options window closes.

6

Re‐export your accounting information. For more information, see ‘Re‐exporting your accounting
information’ on page 51.
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Error occurred retrieving export directory in CExport:FileDir Bad File name or
number
NOTE :

This error only occurs if you are using RetailManager on a network.

The Retail.txt file could not be saved to the folder you specified in the setup options. The folder may
not have access to your network or the file sharing properties of the folder may not be set to share.
You should check the network connections and the file sharing properties associated with the folder
you specified.
To check the network connections associated with the folder you specified
1

Go to the Setup menu and choose Options. The Options window appears.

2

Click Accounting. The Export tab appears.

3

Check that the folder you specified in the Path field has access to your network. If required, contact
your Network Administrator or IT Consultant for assistance.
To check the file sharing properties of the folder

1

[Windows Vista users] Log on as an Administrator.

4

In Windows Explorer, right‐click the folder that you specified to save the Retail.txt file to and
choose Properties. The Properties window appears.

5

Click the Sharing tab.

6

[Windows Vista users] Click Advanced Sharing. The Advanced Sharing tab appears.

7

Select the Share this folder option.

8

Click Permissions. The Permissions window appears.

9

Select the Allow option next to Full Control for all required users.

10

Click Apply and then click OK. The Sharing tab reappears.

11

Click Apply and then click OK.

When you have set the network connections and the folder permissions associated with the folder,
re‐export your accounting information. For more information, see ‘Re‐exporting your accounting
information’ on page 51.
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Error occurred exporting variance in CExport: JournalVariance
There is a problem with your RetailManager database, for example, the database may be corrupted.
To check if your RetailManager database is corrupt you should try rebuilding and compacting your
database and then re‐exporting your accounting information. For information about rebuilding and
compacting your database, see below. If this does not fix the problem, you will need to send your
database to MYOB Technical Support for analysis and repair. For contact details, see ‘Technical
Support’ on page 53.
To rebuild and compact your database
1

Go to the File menu and choose Configuration. A confirmation window appears.

2

Click Yes. Your shopfront is closed and the Shopfront Configuration window appears.

3

Click the Maintenance tab.

4

Select your shopfront.

5

Click Rebuild/Compact. A confirmation window appears.

6

Click Yes. Another confirmation window appears.

7

Click OK. The rebuilding and compacting process begins. When the Shopfront Configuration
window appears, the process is complete.

8

Close the Shopfront Configuration window. The Shopfront Selection window appears.

9

Open your shopfront and then, re‐export your accounting information. For more information, see
‘Re‐exporting your accounting information’ on page 51.
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Error and warning messages when importing
When you import your accounting information into your business management software, a number of
warning messages may appear. An error message may also appear directing you to view an import log
file.


Warning messages—For more information about warning messages, see ‘Warning messages’
below.



Error messages—For more information about error messages, see ‘Error messages’ on page 28.

Warning messages
Warning messages inform you that your accounting information was imported into your business
management software, but the information that was imported was changed in some way. This occurs
when information required by your business management software is automatically assigned during
the import. For example, as you cannot assign a delivery status to Goods Received transactions in
RetailManager, a default delivery status is automatically assigned to all imported Goods Received
transactions.
The following table lists common import warning messages that may appear. If a warning message
appears, but it is not listed in the table below, contact MYOB Technical Support (see page 53).
Warning message

See

Warning 138 ‐ Amount is zero: line ignored

below

Warning 251 ‐ Foreign currency transaction must specify an exchange rate current exchange rate
substituted.

below

Warning 595 ‐ Invalid Delivery Status; current Delivery Status substituted

below

Warning 138 - Amount is zero: line ignored
The Last Cost Variance account in the Retail.txt file is $0. This value was not imported into your business
management software. Note that the last cost variance account records the changing value of your
stock (stock variance).

Warning 251 - Foreign currency transaction must specify an exchange rate current
exchange rate substituted
NOTE :

This message only appears if you use the Multicurrency feature in AccountRight.

This message informs you that transactions have been imported and that the exchange rate used in
your business management software will apply to all imported transactions.

Warning 595 - Invalid Delivery Status; current Delivery Status substituted
As you cannot assign a delivery status to purchases (Goods Received transactions) in RetailManager, a
default delivery status is automatically assigned to all imported purchases. All purchases are imported
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into your business management software as Service type Bills with a ‘P ‐ To be Printed’ delivery status.
You can change this delivery status if you want.
To change the delivery status of a purchase
1

In your business management software, go to the Purchases command centre and click Purchases
Register. The Purchases Register window appears.

2

Click the zoom arrow ( ) next to the purchase you imported from RetailManager. The Purchases
‐ Edit Service window appears.

3

From the Bill Delivery Status list, select how you want to send the bill.

4

Click OK.

Error messages
When there are errors in the Retail.txt file, an information message appears directing you to view a log
file called MYOBPLOG (if you are using AccountRight Premier or Enterprise) or MYOBLOG (if you are
using MYOB AccountRight Standard or MYOB AccountRight Plus). The information message shows
where the MYOBPLOG or the MYOBLOG file is saved to.

If this message appears, you need to open the MYOBPLOG or the MYOBLOG log file in a text editor
program, such Microsoft Notepad or Microsoft Word, and review the error message code and
description listed in the file. You can then use the table below to find out more information about the
error. To fix the error you may need to change the setup options you specified in RetailManager, or edit
the information in the Retail.txt file.
Note that if this information message appears, your accounting information has not been imported
into your business management software. You will need to fix the error and then retry the import.
NOTE :

Import errors in AccountRight 2011 The process for fixing errors in AccountRight Plus 2011 and
AccountRight Standard 2011 is different to that outlined in this guide. Please refer to our support note for
information on how to fix import errors in these versions,. Go to (New Zealand) myobnz.custhelp.com or
(Australia) myob.com.au/supportnotes and search for ID 33722.
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To view the log file
1

In Windows Explorer, locate the MYOBLOG or MYOBPLOG log file. By default this file is saved to
your business management software installation folder:
If you are using...

See...

MYOB Premier
MYOB Premier Enterprise

c:\MYOB Premierxx, where xx is the version number of your software

MYOB Accounting
MYOB Accounting Plus

c:\MYOBxx, where xx is the version number of your software

If you installed your business management software to a different location, refer to the information
message for the address of where the log file is saved.
2

Right‐click the MYOBLOG or MYOBPLOG log file.

3

Choose Open With and click Choose Program. The Open With window appears.

4

From the list of programs, select the program you want to use to view the file. The log file opens in
the program you selected.

5

Note the error message code and description and refer to the table below.

The table below lists the most common error messages. If an error message code and description
appears in the log file, but not in the table, contact MYOB Technical Support (see ‘Technical Support’ on
page 53):
Error message

See

Error 10 ‐ Invalid Date

page 30

Error 11 ‐ Transactions dated before the beginning of your financial year may not be imported

page 30

Error 14 ‐ Invalid account

page 31

Error 15 ‐ Account number not found in list of postable accounts

page 32

Error 16 ‐ Invalid debit amount

page 34

Error 17 ‐ Invalid credit amount

page 34

Error 19 ‐ Unbalanced transaction

page 34

Error 26 ‐ Card not found

page 35

Error 36 ‐ Freight amount invalid

page 36

Error 38 ‐ Default account for freight charges not specified

page 38

Error 84 ‐ Foreign Currency Linked Account is missing

page 39

Error 87 ‐ Invalid tax code for this transaction

page 40

Error 121 ‐ The tax code is invalid: importing cancelled

page 40

Error 122 ‐ Mandatory Inc‐Tax Amount is invalid or blank

page 40
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Error message

See

Error 127 ‐ Transaction dated before your locked period date may not be imported: importing
cancelled

page 42

Error 169 ‐ Job not found in list of detail jobs

page 43

Error 243 ‐ More than 1 supplier found. Purchase order not imported.

page 44

Error 10 - Invalid Date
The dates in the Retail.txt file appear in a different format to the date format used in your business
management software. To fix this issue, you need to set the date format on the computers where you
have installed RetailManager and your business management software to the dd/MM/yyyy date
format. To change the date format on your computers, see ‘Changing the date format on your
computer’ on page 52.
You also need to change the dates in the Retail.txt file to the dd/MM/yyyy date format and then retry
the import.
To change the date format in the Retail.txt file
1

Open the Retail.txt file in Microsoft Excel. For more information, see ‘Editing the Retail.txt file’ on
page 49.

2

Change the dates so that they appear in the following format: dd/MM/yyyy (for example,
21/09/2009).

3

Save and close the Retail.txt file.

4

Retry the import. For more information, see ‘Task 2: Import your shopfront accounting information
into your business management software’ on page 20.

Error 11 - Transactions dated before the beginning of your financial year may not be
imported
Transactions in the Retail.txt file are dated before your business management software’s current
financial year. (Your financial year is the 12‐month period that you use to define your accounting year.
Note that this year may not match the calendar year.)
This can occur for the following reasons:


you are trying to import transactions that are dated in your previous financial year



you have entered a date in the Inv. Date field of a Goods Received transaction that is within your
previous financial year.

You need to review the Retail.txt file and locate the journal entries and Goods Received transactions
that are dated in your previous financial year. You then need to change the dates to your current
financial year.
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To correct transactions in the Retail.txt file
1

Open the Retail.txt file in Microsoft Excel. For more information, see ‘Editing the Retail.txt file’ on
page 49.

2

Locate the dates for journal entries and Goods Received transactions. If required, change the dates
so that they fall within your current financial year.

3

Save and close the file.

4

Retry the import. For more information, see ‘Task 2: Import your shopfront accounting information
into your business management software’ on page 20.

Error 14 - Invalid account
This error can occur for the following reasons:


There is an incorrect account number in the Retail.txt file. For more information, see ‘Incorrect
account number in the Retail.txt file’ below.



You are using RetailManager v8 or v9. For more information, see ‘You are using RetailManager v8
or v9’ below.

Incorrect account number in the Retail.txt file An account number in the Retail.txt file contains an
alphabet character or more than six digits. Note that it is not possible to enter an account number in
the Chart of Accounts tab in the Options window that contains an alphabet character or more than six
digits. Therefore, the most likely cause of this error is that you have manually edited the Retail.txt file
and entered an incorrect account number or your shopfront database is corrupt.
If you have manually edited the Retail.txt file, see ‘To correct the account number if you have manually
edited the Retail.txt file’ below. If you have not manually edited the Retail.txt file, you need to check for
a database corruption. See ‘To check for a database corruption’ below.
To correct the account number if you have manually edited the Retail.txt file
1

Open the Retail.txt file in Microsoft Excel. For more information, see ‘Editing the Retail.txt file’ on
page 49.

2

Locate the account number containing an alphabet character or six or more digits.

3

Change the account number to a different number. The account number that you enter should
exist in your business management software, contain five numeric characters and correspond to a
detail account. Detail accounts are accounts that you can post transactions to.

4

Save and close the file.

5

Retry the import. For more information, see ‘Task 2: Import your shopfront accounting information
into your business management software’ on page 20.
To check for a database corruption

1

Re‐export your accounting information. For more information, see ‘Re‐exporting your accounting
information’ on page 51.

6

Open the Retail.txt file in Microsoft Excel. For more information, see ‘Editing the Retail.txt file’ on
page 49.

7

Locate and review the account numbers. If an account number contains an alphabet character or
more than six characters, your database is corrupt. You should contact MYOB Technical Support for
assistance (see ‘Technical Support’ on page 53).
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Note that you can still fix this error so that you can import your accounting information by manually
editing the account numbers.
To manually edit the account numbers
8

Change the account number to a different account number. The account number that you enter
should exist in your business management software, contain five numeric characters and
correspond to a detail account. Detail accounts are accounts that you can post transactions to.

9

Save and close the file.

10

Retry the import. For more information, see ‘Task 2: Import your shopfront accounting information
into your business management software’ on page 20.

You are using RetailManager v8 or v9 If you are using RetailManager v8 or v9 and you export using
clearing accounts, this error occurs because a line has been omitted between each journal entry. In the
Retail.txt file, journal entries are lines beginning with the number ‘3’. To fix this error, you need to add
a line between each journal entry.
1

Open the Retail.txt file in Microsoft Excel. For more information, see ‘Editing the Retail.txt file’ on
page 49.

2

Insert a line between each journal entry. For information about inserting lines in Excel, see your
Microsoft Excel User Guide.

3

Save and close the file.

4

Retry the import. For more information, see ‘Task 2: Import your shopfront accounting information
into your business management software’ on page 20.

Error 15 - Account number not found in list of postable accounts
This error can occur for the following reasons:


You entered an incorrect account number in the Chart of Accounts tab in the Options window.



An account number in the Retail.txt file contains fewer than five digits.

To fix this error, you should first review the account numbers that you specified in the Chart of
Accounts tab in the Options window (see ‘Specifying account numbers in the Options window’ on
page 33). If the account numbers are correct, you should review the Retail.txt file (see ‘Editing the
Retail.txt file’ on page 49) and check if there are any account numbers with fewer than five digits. If
there is an account number with fewer than five digits, see ‘An account number in the Retail.txt file
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contains fewer than five digits’ on page 33.
Specifying account numbers in the Options window You may have entered an incorrect account
number in the Chart of Accounts tab in the Options window. The account number may be incorrect for
the following reasons:


The account number corresponds to a header account. Header accounts are accounts used to
group similar detail accounts. You cannot post transactions to a header account.



The account number corresponds to your Current Year Earnings account. This is an equity account.
You cannot post your RetailManager journal entries to this account.



The account number does not exist in your business management software.

You should review the account numbers that you entered in the Chart of Accounts tab in the Options
window and if required, enter a different account number (see ‘Task 1: Set up accounting options in
RetailManager’ on page 7). The account number that you enter must exist in your business
management software and correspond to a detail account (detail accounts are accounts that you can
post transactions to). You then need to re‐export your accounting information (see ‘Re‐exporting your
accounting information’ on page 51) and retry the import (see ‘Task 2: Import your shopfront
accounting information into your business management software’ on page 20).
An account number in the Retail.txt file contains fewer than five digits It is not possible to enter
an account number with fewer than five digits in the Chart of Accounts tab in the Options window.
Therefore, the most likely cause of this error is that you have manually edited the Retail.txt file and
entered an account number with fewer than five digits or your shopfront database is corrupt. If you
have manually edited the Retail.txt file, see ‘To correct the account number if you have manually edited
the Retail.txt file’ below. If you have not manually edited the Retail.txt file, you need to check for a
database corruption. See ‘To check for a database corruption’ below.
To correct the account number if you have manually edited the Retail.txt file
1

Open the Retail.txt file in Microsoft Excel. For more information, see ‘Editing the Retail.txt file’ on
page 49.

2

Locate the account number containing fewer than five digits.

3

Change the account number to a different number. The account number that you enter should
exist in your business management software, contain five characters and correspond to a detail
account. Detail accounts are accounts that you can post transactions to.

4

Save and close the file.

5

Retry the import. For more information, see ‘Task 2: Import your shopfront accounting information
into your business management software’ on page 20.
To check for a database corruption

1

Re‐export your accounting information. For more information, see ‘Re‐exporting your accounting
information’ on page 51.

6

Open the Retail.txt file in Microsoft Excel. For more information, see ‘Editing the Retail.txt file’ on
page 49.

7

Locate and review the account numbers. If an account number contains fewer than five digits, your
database is corrupt. You should contact MYOB Technical Support for assistance (see ‘Technical
Support’ on page 53).
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Note that you can still fix this error so that you can import your accounting information by manually
editing the account numbers.
To manually edit the account numbers
1

Change the account number to a different account number. The account number that you enter
should exist in your business management software, contain five characters and correspond to a
detail account. Detail accounts are accounts that you can post transactions to.

2

Save and close the file.

3

Retry the import. For more information, see ‘Task 2: Import your shopfront accounting information
into your business management software’ on page 20.

Error 16 - Invalid debit amount
A barcode may have been scanned into the Sell field when a sale was reversed. This affects one or more
debit amounts in the Retail.txt file. You need to locate the incorrect amount in the Retail.txt file and
change it to the correct amount.
1

Open the Retail.txt file in Microsoft Excel. For more information, see ‘Editing the Retail.txt file’ on
page 49.

2

Locate the incorrect amount.

3

Specify the correct amount. To locate the correct amount use the Lookup Transactions window or
print the relevant transaction reports.

4

Save and close the file.

5

Retry the import. For more information, see ‘Task 2: Import your shopfront accounting information
into your business management software’ on page 20.

Error 17 - Invalid credit amount
A barcode may have been scanned into the Sell field when a sale was reversed. This affects one or more
credit amounts in the Retail.txt file. You need to locate the incorrect amount in the Retail.txt file and
change it to the correct amount.
 To fix this error, see ‘Error 16 ‐ Invalid debit amount’ above.

Error 19 - Unbalanced transaction
CAUTION :

This error can be difficult to fix. If you require assistance, contact MYOB Technical Support. For
contact details, see ‘Technical Support’ on page 53.

There is an unbalanced transaction in the Retail.txt file. An unbalanced transaction is when the debit
entries do not equal the credit entries. It is not possible to record an unbalanced transaction in
RetailManager. Therefore, the most likely cause of this error is that you have manually edited the
Retail.txt file and entered an incorrect amount or the correct amount in the wrong column.
You can fix this error by re‐exporting your accounting information. However, you should note that if
you re‐export your accounting information, you will overwrite any changes that you made when you
manually edited the Retail.txt file. If you want to re‐export your accounting information, see
‘Re‐exporting your accounting information’ on page 51. When you have re‐exported your accounting
information, you will then need to retry the import. For more information, see ‘Task 2: Import your
shopfront accounting information into your business management software’ on page 20.
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Alternatively, you can fix this error by editing the information in the Retail.txt file. If you want to do this,
you need to locate the unbalanced transaction in the Retail.txt file and then, balance the transaction by
recording the correct amount or entering the amount in the correct column.
1

Open the Retail.txt file in Microsoft Excel. For more information, see ‘Editing the Retail.txt file’ on
page 49.

2

Check that the debit and credit entries for each journal entry balance. A journal entry is balanced
when amounts appear in the correct column and when the total debit amounts equal the total
credit amounts.
NOTE :

In Microsoft Excel, debit entries appear in column E and credit entries appear in column F.
However, the first journal entry is indented one column to the right.
3

Locate the unbalanced transaction.

4

Note the cashup session that it relates to and then, locate the correct amount.
To locate the correct amount you need to view the Sales Summary and the Cash Summary cashup
reports. To view these reports, go to the Reconciliation menu and choose Print Cashup Reports.
For more information about cashup reports, see the ‘Cashing Up’ chapter in your MYOB
RetailManager User Guide.

5

Record the correct amount or move an amount to the correct column.

6

When you are finished, save and close the file.

7

Retry the import. For more information, see ‘Task 2: Import your shopfront accounting information
into your business management software’ on page 20.

Error 26 - Card not found
The supplier name for a purchase (Goods Received transaction) in the Retail.txt file does not match the
supplier name in your MYOB business management software. You may have changed the spelling of a
supplier name in your business management software or the supplier name in the Retail.txt file may
have been truncated to 30 characters or fewer.
NOTE :

New supplier names are exported to the new supplier cards section of the Retail.txt file (lines
beginning with the number one). They retain their full names. On the other hand, supplier names for
purchases are exported to the purchases (goods received) section of the Retail.txt file (lines beginning with
the number two). Supplier names for purchases are truncated to 30 characters.

To fix this, you need to review the supplier names for purchases in the Retail.txt file:


If you have changed the spelling of a supplier name in your business management software, you
should change the spelling of the supplier name in either RetailManager or in your business
management software so that they match.



If the supplier name has been truncated to 30 characters or fewer, you need to truncate the
supplier name in RetailManager to 30 characters or fewer and then re‐export your accounting
information. You should also truncate the supplier name in your business management software.

Before you begin You need to refer to your RetailManager and your business management software
supplier lists. In RetailManager, go to the Information menu and choose Suppliers. Then, in the
Suppliers window, click the search icon ( ). In your business management software, go to the Card
File command centre and click Cards List. Then, click the Supplier tab.

ERROR AND WARNING MESSAGES WHEN IMPORTING

35

1

Open the Retail.txt file in Microsoft Excel. For information, see ‘Editing the Retail.txt file’ on
page 49.

2

Review the supplier names for purchases (Goods Received transactions). In the Retail.txt file,
purchases are lines labelled with the number ‘2’.
If...

Then...

a supplier name has
been truncated to 30
characters

1

Truncate the supplier name in RetailManager to 30 characters or fewer. For
information about editing RetailManager suppliers, see the ‘Stock
Management’ chapter in your RetailManager User Guide.

2

Truncate the supplier name in your business management software. For
information about editing supplier cards, see the ‘Lists’ chapter in your
business management software User Guide.

3

Re‐export your accounting information. For more information, see
‘Re‐exporting your accounting information’ on page 51.

4

Retry the import. For more information, see ‘Task 2: Import your shopfront
accounting information into your business management software’ on page 20.

1

Edit the supplier name in either RetailManager or in your business
management software so that they match.

2

Re‐export your accounting information. For more information, see
‘Re‐exporting your accounting information’ on page 51.

3

Retry the import. For more information, see ‘Task 2: Import your shopfront
accounting information into your business management software’ on page 20.

a supplier name is spelt
differently in
RetailManager
compared with your
business management
software

Error 36 - Freight amount invalid
CAUTION :

This error can be difficult to fix. If you require assistance, contact MYOB Technical Support. For
contact details, see ‘Technical Support’ on page 53.

A bar code may have been scanned into the Freight field of a Goods Received or Returned Goods
transaction. The bar code has been interpreted as the cost of freight and added to the total of the
Goods Received or Returned Goods transaction.
To fix this error, you need to enter the correct freight amount in the Retail.txt file and then import your
accounting information. You then need to fix the incorrect freight amount in RetailManager and then
export and import your accounting information.
Task

See

1

Record the correct freight amount in the Retail.txt file and then, import
your accounting information.

page 37

2

Reverse the transaction in RetailManager by entering a transaction
with a negative freight amount. Then, export your accounting
information.

page 37

3

Change the negative freight amount in the Retail.txt file to zero and
then, import your accounting information.

page 37
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To record the correct freight amount
1

Open the Retail.txt file in Microsoft Excel. For more information, see ‘Editing the Retail.txt file’ on
page 49.

2

Locate the incorrect freight amount. Freight amounts appear in column Z (ex‐tax freight), column
AA (inc‐tax freight) and column AD (tax on freight). Note that the incorrect freight amount will be a
large number.

3

Record the correct freight amount. You will need to edit all three amounts.

4

Save and close the file.

5

Retry the import. For more information, see ‘Task 2: Import your shopfront accounting information
into your business management software’ on page 20.
To reverse the transaction in RetailManager

1

Calculate the amount of the reversal. The amount of the reversal will be the correct freight amount
less the incorrect freight amount. For example, $50 (correct freight amount) ‐ $543,098,765.40
(incorrect freight amount) = ‐$543,098,715.40. This is the amount of the reversal transaction.

6

Go to the Transaction menu and choose Goods Received.

7

Enter a staff number and supplier. Do not enter any other information.

8

In the Freight field, enter the amount of the reversal as a negative number.

9

Click Commit ‐ F10 to record the transaction.

10

Cash up.

11

Export your accounting information. For more information, see ‘Re‐exporting your accounting
information’ on page 51.
To change the negative freight amount to zero

You now need to change the negative freight amount in the Retail.txt file to zero so that you do not
import this amount into your business management software.
1

Open the Retail.txt file in Microsoft Excel. For more information, see ‘Editing the Retail.txt file’ on
page 49.

12

Change the freight amounts in column Z (ex‐tax freight), column AA (inc‐tax freight) and column AD
(tax on freight) for the reversal transaction to zero.

13

Save and close the file.

14

Import your accounting information. For more information, see ‘Task 2: Import your shopfront
accounting information into your business management software’ on page 20.
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Error 38 - Default account for freight charges not specified
A linked account for freight on sales or freight on purchases is not specified in your business
management software. You need to specify the relevant linked accounts and then retry the import (see
‘Task 2: Import your shopfront accounting information into your business management software’ on
page 20).
1

Specify an account for freight on sales:
a In your business management software, go to the Setup menu and choose Linked Accounts and
then, choose Sales Account. The Sales Linked Accounts window appears.

b
c
2

Select the I charge Freight on Sales option and enter an account number.
Click OK. The Sales Linked Accounts window closes.

Specify an account for freight on purchases:
a Go to the Setup menu, choose Linked Accounts and then, choose Purchases Accounts. The
Purchases Linked Accounts window appears.

Select the I pay freight on purchases option and enter an account number.
If you need to create an account number, see the ‘Setting up your company file’ chapter in your
business management software User Guide.
c Click OK. The Purchases Linked Accounts window closes.
b
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Error 84 - Foreign Currency Linked Account is missing
One of the following linked accounts has not been specified in your business management software:


Linked Accounts for payable accounts for foreign currencies. For more information, see ‘To specify
linked payable accounts for foreign currencies’ below.



Linked Accounts for sales and purchases. For more information, see ‘To specify linked accounts for
sales and purchases’ on page 39.



Linked Accounts for tax collected and tax paid. For more information, see ‘To specify linked
accounts for tax codes’ below.

You need to specify all relevant linked accounts and then retry the import (see ‘Task 2: Import your
shopfront accounting information into your business management software’ on page 20).
To specify linked payable accounts for foreign currencies
1

In your business management software, go to the Lists menu and choose Currencies. The
Currencies List window appears.

2

Click the zoom arrow (

3

Click the Payable Accounts tab.

4

Enter the relevant account numbers. For more information about foreign currency payable
accounts, see the ‘International Transactions’ chapter in your business management software User
Guide.

5

Click OK. The Currencies List window reappears.

6

Repeat from step 2 above for each foreign currency.

) next to a foreign currency. The Currency Information window appears.

To specify linked accounts for sales and purchases
1

Go to the Setup menu, choose Linked Accounts and then, choose Sales Accounts. The Sales Linked
Accounts window appears.

7

Select the I charge freight on Sales option and enter an account number.

8

Click OK. The Sales Linked Accounts window closes.

9

Go to the Setup menu, choose Linked Accounts and then, choose Purchases Accounts. The
Purchases Linked Accounts window appears.

10

Select the I pay Freight on Purchases option and enter an account number.

11

Click OK. The Purchases Linked Accounts closes.
To specify linked accounts for tax codes

1

Go to the Lists menu and choose Tax Codes. The Tax Code List window appears.

12

Click the zoom arrow (

13

Specify a linked account for tax collected and a linked account for tax paid.

14

Click OK. The Tax Code List window reappears.

15

Repeat from step 12 above for each tax code in the list.

16

When you are finished, close the Tax Code List window.

) next to a tax code. The Tax Code Information window appears.
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Error 87 - Invalid tax code for this transaction
A non‐sales tax code, such as INP or GNR, has been used in a sales transaction. Note that you cannot
record a sales transaction in RetailManager with a non‐sales tax code. Therefore, the most likely cause
of this error is that you have manually edited the Retail.txt file and entered a non‐sales tax code.
To fix this error, you need to correct the tax code in the Retail.txt file and then retry the import.
1

Open the Retail.txt file in Microsoft Excel. For more information, see ‘Editing the Retail.txt file’ on
page 49.

2

Locate any journal entries with non‐sales tax codes.

3

Enter the correct tax code.

4

Save and close the file.

5

Retry the import. For more information, see ‘Task 2: Import your shopfront accounting information
into your business management software’ on page 20.

Error 121 - The tax code is invalid: importing cancelled
There is a tax code set up in RetailManager that has not been set up in your business management
software. The relevant tax code will be listed in the MYOBLOG.txt or the MYOBPLOG.txt log file. You
need to set up the tax code in your business management software and then retry the import.
1

In your business management software, go to the Lists menu and choose Tax Codes. The Tax Codes
List window appears.

2

Click New. The Tax Code Information window appears.

3

Type a code, description and type.

4

When you are finished, click OK. The Tax Code List window reappears.

5

Retry the import. For more information, see ‘Task 2: Import your shopfront accounting information
into your business management software’ on page 20.

Error 122 - Mandatory Inc-Tax Amount is invalid or blank
A bar code may have been scanned into the Unit Cost field in a Goods Received or Returned Goods
transaction. The bar code has been interpreted as the cost of the item and added to the total of the
Goods Received or Returned Goods transaction.
To fix this error, you need to enter the correct amount in the Retail.txt file and then import your
accounting information. You then need to fix the incorrect amount in RetailManager and then export
and import your accounting information.
CAUTION :

Before you continue This error can be difficult to fix. If you do not operate on an Average Cost
stock costing basis, you should contact MYOB Technical Support for assistance. For contact details, see
‘Technical Support’ on page 53.
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Task

See

1

Locate the incorrect amount in the Retail.txt file and change it to
zero. Then, import your accounting information.

‘To change the incorrect amount in
the Retail.txt file to zero’ below

2

Reverse the transaction in RetailManager by entering a
transaction with a negative amount.

‘To reverse the transaction’ below

3

Record the correct transaction in RetailManager. Then, export
your accounting information.

‘To record the correct transaction’
on page 42

4

Change the negative amount (the reversal transaction) in the
Retail.txt file to zero. Then, import your accounting information.

‘To change the negative amount in
the Retail.txt to zero’ on page 42

To change the incorrect amount in the Retail.txt file to zero
1

Open the Retail.txt file in Microsoft Excel. For more information, see ‘Editing the Retail.txt file’ on
page 49.

2

Locate the incorrect amount. The incorrect amount will be a large amount appearing in column Q
(for example, 543,322,456.00).

3

Change the amount in column Q to zero.

4

Save and close the file.

5

Retry the import. For more information, see ‘Task 2: Import your shopfront accounting information
into your business management software’ on page 20.
NOTE :

The purchase is imported into your business management software as a closed bill. No action is
required on this bill.

To reverse the transaction
1

Go to the Transaction menu:
If you are reversing a...

Choose...

Goods Received transaction

Goods Received

Returned Goods transaction

Returned Goods

6

Enter the details for the Goods Received or Returned Goods transaction.

7

In the Unit Cost field, enter the incorrect amount as a negative value (for example,
‐543,322,456.00).

8

Click Commit ‐ F10 to record the transaction.
To record the correct transaction

1

Go to the Transaction menu:
If you are recording a...

Choose...

Goods Received transaction

Goods Received

Returned Goods transaction

Returned Goods
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9

Specify the details for the Goods Received or Returned Goods transaction.

10

In the Unit Cost field, enter the correct amount.

11

Click Commit ‐ F10 to record the transaction.

12

Cash up.

13

Export your accounting information. For more information, see ‘Task 1: Export your shopfront
accounting information from RetailManager’ on page 18.
To change the negative amount in the Retail.txt to zero

You now need to change the amount of the reversal transaction in the Retail.txt file to zero so that you
do not import this amount into your business management software.
1

Open the Retail.txt file in Microsoft Excel. For more information, see ‘Editing the Retail.txt file’ on
page 49.

14

Locate the large negative amount in column Q (for example, ‐543,322,456.00).

15

Change the amount in column Q to zero.

16

Save and close the file.

17

Import your accounting information. For more information, see ‘Task 2: Import your shopfront
accounting information into your business management software’ on page 20.

Error 127 - Transaction dated before your locked period date may not be imported:
importing cancelled
You have set a lock period in your business management software and you are trying to import
transactions dated within that period. You need to unlock the period and then retry the import. When
you have imported your accounting information into your business management software, you should
then reset the lock period.
1

In your business management software, go to the Setup menu and choose Preferences. The
Preferences window appears.

2

Click the Security tab.

3

Deselect the Locked Period: Disallow Entries Prior To option.

4

Click OK.

5

Retry the import. For more information, see ‘Task 2: Import your shopfront accounting information
into your business management software’ on page 20.

Error 169 - Job not found in list of detail jobs
The job number that you specified in the Export tab of the Options window in RetailManager may not
exist in your business management software or the job number may correspond to a header job (you
cannot assign transactions to a header job).
You need to review the job number that you specified in the setup options and check that this number
exists in your business management software and that it corresponds to a detail job (you can assign
transactions to detail jobs). For more information about jobs, see the ‘Financial Control’ chapter in
your business management software User Guide.
Before you begin To complete this procedure, you need to review your business management
software jobs list. In your business management software, go to the Lists menu and choose Jobs.
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To check the job number that you specified in RetailManager
1

In RetailManager, go to the Setup menu and choose Options. The Options window appears.

2

Click Accounting. The Export tab appears.

3

Note the job number in the Job Number field.

4

Review your business management software jobs list and check that this job number exists and
that it corresponds to a detail job.

5

If required, either:
 create the job number in your business management software or
 enter a job number in RetailManager that corresponds to a detail job.

6

In the Export tab, click OK.

7

Close the Options window.

8

Re‐export your accounting information. For more information, see ‘Re‐exporting your accounting
information’ on page 51.

9

Retry the import. For more information, see ‘Task 2: Import your shopfront accounting information
into your business management software’ on page 20.

Error 243 - More than 1 supplier found. Purchase order not imported.
There are two identical supplier cards in your business management software for a purchase (Goods
Received transaction) that you are trying to import. The supplier name on the cards may be spelt the
same, but the names may have been entered in different cases.

To fix this error, you should compare the supplier names for purchases (Goods Received transactions)
in the Retail.txt file with the supplier cards in your business management software. When you have
identified the duplicate card in your business management software, you need to combine the two
cards or change the name of one of the cards. For example, you may want to add a location to one of
the cards (for example, ‘Clearwater Stationery ‐ City’).
Before you begin You need to refer to your business management software supplier lists. In your
business management software, go to the Card File command centre and click Cards List. Then, click
the Supplier tab.
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1

Open the Retail.txt file in Microsoft Excel. For more information, see ‘Editing the Retail.txt file’ on
page 49.

2

Compare the supplier names for purchases (lines beginning with the number two) with the
supplier cards in your business management software supplier list.

3

When you have identified the duplicate card in your business management software, either:
 combine the cards. For information about combining cards, see the ‘Lists’ chapter in your
business management software User Guide.
 change the name of one of the cards.

4

When you are finished, retry the import. For more information, see ‘Task 2: Import your shopfront
accounting information into your business management software’ on page 20.
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Resolving a stock value discrepancy
After integrating your shopfront accounting information with your back office accounting information,
you may find that there is a discrepancy between the value of your stock in RetailManager and the
value of your stock in your business management software. This is called a stock value discrepancy and
it can occur for a number of reasons. For example, you may have entered stock transactions directly in
your business management software without first entering them in RetailManager.
NOTE :

Stock value discrepancies can be difficult to fix. If you require assistance, contact MYOB Technical
Support. For contact details, see ‘Technical Support’ on page 53.

To fix a stock discrepancy, you first need to determine the last time when stock values were correct. You
then need to determine how the discrepancy occurred. Once you have determined how the
discrepancy occurred, you can fix the problem by following the solution provided.
Task

See

1

Determine the last time when stock values were correct

below

2

Determine how the discrepancy occurred

page 46

Task 1: Determine the last time when stock values were
correct
To determine the last time when stock values were correct, you need to compare the stock values in
RetailManager for a particular cash up session with the stock values for the same day in your business
management software.
You can do this by comparing the following figures:


the stock value shown in the Stock Value field in RetailManager’s Sales Summary report



the ending balance for the Inventory account shown in the Ending Balance field in the Find
Transactions window in your business management software.

1

In RetailManager, open the Sales Summary report for a previous cashup session:
a Go to the Reconciliation menu and choose Print Cashup Reports. The Print Cashup Reports
window appears.
b Select the cashup session.
c Select the Sales Summary option and then, click View.

2

In your business management software, open the Find Transactions window showing transactions
for the inventory account:
a From the command centre, click Find Transactions. The Find Transactions window appears.
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Click the Account tab.
From the Search by list, select the Inventory account.
d In the Dated From fields, enter the date of the cash up session.
b
c

3

Compare the value that appears in the Stock Value field in the Sales Summary report with the
value that appears in the Ending Balance column in the Find Transactions window.
In RetailManager: Sales Summary report




In your business management software:
Find Transactions window

If these values are the same, repeat from step 1 on page 45 choosing an earlier date.
If these values are different, go to ‘Task 2: Determine how the discrepancy occurred’ below.

Task 2: Determine how the discrepancy occurred
You need to determine how the stock discrepancy occurred before you can fix the problem. Review
each of the reasons below and then follow the solution provided.

You specified an incorrect amount when you entered your inventory opening
balances in your business management software
If you performed ‘Task 1: Determine the last time when stock values were correct’ on page 45 and
found that the stock values in RetailManager and in your business management software were
different for each cashup session, then you have:


entered an incorrect opening balance in your business management software. Note that the
inventory opening balance that you entered in your business management software should have
been the total value of your RetailManager stock before you had made a sale or recorded a Goods
Received transaction. For help resolving this issue, contact MYOB Technical Support (see ‘Technical
Support’ on page 53).



changed your inventory opening balance in your business management software. If you have
changed your inventory opening balance in your business management software, do the following:
a Restore a backup of your business management software company file. The backup file will be
used for reference only.
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Compare the inventory opening balance in your restored company file with the inventory
opening balance in your current company file.
c Change the inventory opening balance in your current company file to match the inventory
opening balance in your restored company file. If you require assistance, contact MYOB
Technical Support. For more information, see ‘Technical Support’ on page 53.
b

Journal entries were imported twice
You exported a cashup session and imported it into your business management software. You then
reexported a cashup session and then imported the same journal entries into your business
management software. As a result a journal entry may have been duplicated in your business
management software. If a journal entry has been duplicated in your business management software,
you need to delete the duplicate entry.
1

In your business management software, go to the Inventory command centre and click
Transaction Journal. The Transaction Journal window appears.

2

Click the General tab.

3

Review the journal entries checking for any duplicate entries.

4

If required, delete the duplicate journal entry:
a Click the zoom arrow ( ) next to the relevant journal entry. The Record Journal Entry window
appears.
b Go to the Edit menu and choose Delete General Journal transaction. The Transaction Journal
window reappears and the transaction is deleted.

You entered stock transactions directly into your business management software
without entering the same transactions in RetailManager
You need to identify any transactions that you entered directly into your business management
software (that is, any transactions that were not imported from RetailManager). You then need to
delete these transactions and enter an appropriate transaction in RetailManager. When you perform
the accounting integration, the relevant transactions will then be added to your business management
software.
To identify transactions that you entered directly into your business management software, do the
following:
1

From the command centre, click Find Transactions. The Find Transactions window appears.

2

Click the Account tab.

3

From the Search by list, select the Inventory account.

4

In the Dated From fields, enter a date range. Transactions recorded within this date range appear.

5

Identify any transactions that you manually entered in your business management software and
delete them.
NOTE :

Transactions that have been imported from RetailManager appear with ‘Purchase
RetailManager’ or ‘Inventory Adjustment’ in the Memo field. Do not delete these transactions.
6

Enter a corresponding transaction in RetailManager.

7

Export your accounting information. For more information, see ‘Task 1: Export your shopfront
accounting information from RetailManager’ on page 18.
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8

Import your accounting information. For more information, see ‘Task 2: Import your shopfront
accounting information into your business management software’ on page 20. When you import,
the relevant transactions are then added to your business management software.

You imported incorrect stock quantities into your RetailManager stock file
This can occur for the following reasons:


Stock quantities that you imported into RetailManager did not take into account the items that
you sold while performing a stocktake. You exported your stock file to perform a stocktake. During
the stocktake, you sold some items. You finished your stocktake and imported your stock file back
into RetailManager and you chose to match all fields by name, including the quantity field.
Incorrect stock quantities were imported into RetailManager.



You manually edited the stock file and entered the wrong stock quantities. You exported your
stock file to perform a stocktake. You opened the stock file in Microsoft Excel and you manually
changed the stock quantities. The stock quantities that you entered were incorrect. You then
imported these stock quantities into RetailManager.

To fix this issue, you need to locate the correct stock quantities and then enter these quantities in
RetailManager. To locate the correct stock quantities, restore a backup of your shopfront database.
Note that the backup file will be used for reference only.
When you perform a stocktake, a backup file is automatically created (see your c: RetailM\shopfront
folder). For more information about restoring a back up, see the ‘Administration’ chapter in your
RetailManager User Guide.

You created a Sales Order, Quote or Lay-by when the cost price of an item was $0.


You created a stock item and entered the cost price as ‘$0’. You then created a sales order, quote or
lay‐by and added this item.



You received goods into stock and performed a Goods Received transaction. In the Goods Received
transaction, you entered the correct cost and sell prices (for example, $50.00).



When you converted the Sales Order, Quote or Lay‐by to a Sale, the cost price reverted to $0. You
then exported the cash up session.

The result is that the inventory account in your business management software has been credited with
an incorrect amount (for example, $45.00, this is $50.00 less the tax amount).
To fix this problem, you need to enter a general journal entry in your business management software to
reduce the value of your inventory account by the cost price of the items in the sale.
To complete this procedure, you need the following information:


The cost price of the items in the sale.



Your Inventory and Cost of Goods account numbers. In RetailManager, go to the Setup menu and
choose Options. Click Accounts and then, click the Chart of Accounts tab. Note the Inventory
account number and the Cost of Goods account number.

RESOLVING A STOCK VALUE DISCREPANCY

48

To record an adjusting general journal entry
1

In your business management software, go to the Accounts command centre and click Record
Journal Entry. The Record Journal Entry window appears.

2

Create a journal entry that debits the Cost of Goods account and credits the Inventory account by
the cost price of the items in the sale.

3

Select the NT tax code in each line of the journal entry.

4

Click Record.

Editing the Retail.txt file
You may need to edit the information in the Retail.txt file to fix errors that appear during the
accounting integration.
We recommend that you edit the Retail.txt file using Microsoft Excel. The structure of Microsoft Excel
makes it easier to locate the error and make your required changes while retaining the formatting of
the file.
Use care when editing the Retail.txt file. Do not add or delete any spaces or change the formatting of
the file. You should only edit the information required to fix the error. If you add or delete any
additional information, you may import an error into your business management software.

To edit the Retail.txt file in Microsoft Excel
1

In Windows Explorer, locate the Retail.txt file. By default, this file is saved to your business
management software installation folder:
If you are using...

See...

MYOB Premier
MYOB Premier Enterprise

c:\MYOB Premierxx, where xx is the version number of your software

MYOB Accounting

c:\MYOBxx, where xx is the version number of your software

If you installed your business management software in a different location, you can review the
location in the Path field in the Export tab of the Options window. For more information, see
‘Task 1: Set up accounting options in RetailManager’ on page 7.

2

Right‐click the Retail.txt file and choose Open With. Then, click Choose Program. The Open With
window appears.
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3

Select Microsoft Excel from the list and then, click OK. The Retail.txt file opens in Microsoft Excel.
F

A
B
C
E

A

Rows starting with ‘0’ are tax codes. These tax codes are matched to the tax codes listed in your business
management software.

B

Rows starting with ‘1’ are new suppliers. New supplier cards are created in your business management
software for each new supplier.

C

Rows starting with ‘2’ are Goods Received transactions (purchases and returns). ‘RA’ in column ‘I’
denotes a return. Goods Received transactions are imported into your business management software
as Service type Bills. Note that if a Goods Received transaction contains different tax codes, there will be
additional lines omitting the number ‘2’.

E

Rows starting with ‘3’ are general journal entries. Note that the first entry is indented one column to the
right.

F

Debit entries appear in column E and credit entries appear in column F. Note that the first entry is
indented one column to the right.

4

Make your required changes.

5

When you have finished, save and close the file:
a Go to the File menu and choose Save. An information message appears.

Click Yes. The Microsoft Excel spreadsheet reappears.
Go to the File menu and choose Close. A confirmation message appears.
d Click Yes. If the information message appears again, click Yes. The file closes.
b
c

When you have edited the information in the Retail.txt file you need to retry the import. For more
information, see ‘Task 2: Import your shopfront accounting information into your business
management software’ on page 20.
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Re-exporting your accounting information
If you have fixed an error by changing the accounting export setup options in RetailManager, you will
need to re‐export your accounting information.

To re-export your accounting information
1

Go to the File menu and choose Accounting Export. An information message appears.

2

Click OK. The export window appears.

3

Double‐click the session number of the cashup session you want to re‐export. You can re‐export
more than one cashup session. An information message appears.

4

Click Yes. An information message appears.
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5

Click Yes. The export window reappears and the status of the cashup session changes to Will be
Exported.

6

Click Export. A confirmation message appears.

7

Click OK. The export window reappears. The status of the cash up session changes to exported.

8

Close the export window.
Your accounting information has been exported to the Retail.txt file. You now need to retry the
import. For more information, see ‘Task 2: Import your shopfront accounting information into your
business management software’ on page 20.

Changing the date format on your computer
If your shopfront and business management software are installed on different computers, you need to
set the date format on each computer to dd/MM/yyyy.

To change the date format
1

Open the Windows Regional and Language Control Panel. The Regional and Language Options
window appears.

2

Set your format to:
 [Australia] English (Australia)
 [New Zealand] English (New Zealand).

3

Click the Location tab and set your location to:
 [Australia] Australia
 [New Zealand] New Zealand.

4

Click Apply.

5

Click OK to save your changes.
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5

Technical Support

If you require assistance with the accounting integration process, contact MYOB Technical Support:


Australia—see ‘Technical Support (Australia)’ below



New Zealand—see ‘Technical Support (New Zealand)’ on page 56.

Technical Support (Australia)
NOTE :

MYOB Technical Support cannot provide assistance with issues arising from hardware or operating
system faults, or incompatible hardware or software. You may need to contact an MYOB RetailManager
Professional Partner if these issues arise.

Retail Technical Support phone numbers and charges
Support Plan

Phone number

Available times (EST)

Charges

MYOB Cover

1300 555 115

We’re open seven days a
week (except for National
holidays). Check our website
for opening hours.

Local call charges

Pay‐Per‐Call Support:

1300 555 128

We’re open seven days a
week. Check our website for
opening hours.

Local call charges and
Pay‐Per‐Call charges.
To find out what our current
Pay‐Per‐Call charges are, call
1300 555 115.

Prepare before you call technical support


Register your software. The technical support team will not be able to help you if you have not
registered your software.



Try to recall exactly what you did before the error occurred and note the exact wording of any
messages that appear.



Be ready to quote your serial number. The serial number is printed on the CD sleeve.



Call while sitting at your computer with RetailManager or your business management software
running (if possible).



Be ready to follow the instructions and advice of the technical support staff and have a pen and
paper ready to record instructions.



Find out the following about your computer and RetailManager:
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The version number of RetailManager. To locate the version number, start RetailManager, then go
to the Help menu and choose About MYOB RetailManager.
Your computer type, processor and model and the version number of the operating system you are
running. To locate this information:





If you are using...

Do this...

Windows Vista

1

Go to the Start menu.

2

Right‐click Computer and choose Properties. The System window displays
the hardware and operating system details.

1

Right‐click the My Computer desktop icon.

2

Choose Properties and then click the General tab. The System Properties
window displays the hardware and operating system details.

Windows XP

MYOB Cover
You are entitled to one year of MYOB Cover, starting from the date you register MYOB RetailManager.
NOTE :

Subscription users Users who have subscribed to RetailManager are entitled to MYOB Cover for the
duration of their subscription.

Maintaining your MYOB Cover subscription provides you with:


technical support seven days a week



all upgrades and updates we release for your product



regular communications including Coverage, our monthly e‐newsletter



exclusive discounts and special offers.

For the terms and conditions of MYOB Cover, visit myob.com.au/cover
Pay‐Per‐Call Support If you do not renew your MYOB Cover subscription, you can access MYOB
technical support on a Pay‐Per‐Call basis. Pay‐Per‐Call Support is charged at a per‐minute rate and a
minimum charge applies. Prices and conditions are subject to change without notice and are available
from MYOB by calling 1300 555 115.
Keep up to date with RetailManager on the Web The MYOB website (myob.com.au/retail) is
updated frequently and contains the latest RetailManager information, news, and links to many useful
resources.
Support notes You can access a wide range of technical support notes at myob.com.au/supportnotes
Send us your feedback We welcome your suggestions for improvements and changes to our
software. Go to myob.com/ideas and complete the online form, or go to the Help menu and click Send
Product Suggestions.
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MYOB training options
MYOB RetailManager Professionals MYOB RetailManager Professionals provide independent
on‐site assistance with MYOB RetailManager and associated products and services, including:


Retail business system needs and analysis



RetailManager installation, setup and implementation



Point‐of‐sale hardware and peripheral solutions



On‐site training and support for RetailManager



RetailManager database maintenance



Integration with MYOB business management software.

As independent businesses, MYOB RetailManager Professionals offer a range of services.
To discuss your retail needs with an MYOB RetailManager Professional near you, visit the Partners
section of the MYOB website: myob.com.au
MYOB Training If you want to know more about how RetailManager can improve the profitability of
your retail business, enrol in an MYOB RetailManager course. An MYOB RetailManager course will
show you how to set up your system correctly from the start, and how to use RetailManager’s many
features to help you improve your store’s sales performance. For more information about your training
options, visit myob.com.au/training
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Technical Support (New Zealand)
NOTE :

MYOB Technical Support cannot provide assistance with issues arising from hardware or operating
system faults, or incompatible hardware or software. You may need to contact an MYOB RetailManager
Professional if these issues arise.

Retail technical support phone numbers and charges
Support Plan

Telephone

Available times

Charges

RetailManager
businesSUPPORT
By subscription only

0508 123 123

We’re open seven days a week
(except for National holidays).
Check our website for opening
hours.

Calls are free when
subscription is paid.

Prepare before you call technical support


Register your software. The technical support team will not be able to help you if you have not
registered your software.



Try to recall exactly what you did before the error occurred and note the exact wording of any
messages that appear.



Be ready to quote your serial number. The serial number is printed on the CD sleeve.



Call while sitting at your computer with RetailManager or your business management software
running (if possible).



Be ready to follow the instructions and advice of the technical support staff and have a pen and
paper ready to record instructions.



Find out the following about your computer and RetailManager:
 The version number of RetailManager. To locate the version number, start RetailManager, then go
to the Help menu and choose About MYOB RetailManager.
 Your computer type, processor and model and the version number of the operating system you are
running. To locate this information:
If you are using...

Do this...

Windows Vista

1

Go to the Start menu.

1

Right‐click Computer and choose Properties. The System window displays
the hardware and operating system details.

1

Right‐click the My Computer desktop icon.

2

Choose Properties and then click the General tab. The System Properties
window displays the hardware and operating system details.

Windows XP
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Technical support options
MYOB businesSUPPORT Registering your MYOB RetailManager software and subscribing to the
RetailManager businesSUPPORT plan entitles your business to enhancement and support, keeping your
retail business up to date with the latest version of RetailManager, the latest tips and techniques, and
information about how any changes in the business and legislation environment might affect your
business.
NOTE :

Subscribing to MYOB businesSUPPORT Continuous subscription to RetailManager businesSUPPORT
is required for the legal operation of your MYOB RetailManager software. The purchase price of each
RetailManager product includes 12 months’ subscription to RetailManager businesSUPPORT. After this time,
you need to renew your subscription to continue using your MYOB RetailManager software.

Maintaining your businesSUPPORT subscription provides you with:


Automatic software upgrades—automatically upgrade to a new version of your MYOB
RetailManager product when it is released during the course of your subscription, keeping your
business up to date with the latest retail business management technology.



Quarterly issues of MYOB InFocus—a year’s subscription to the quarterly publication written by
MYOB Technical Communications specialists, providing you with tips and techniques to help you
get the most out of your retail business management and accounting system.



0508 number access to MYOB technical support—telephone an MYOB technical support specialist
for advice about your MYOB RetailManager software. You can call technical support on
0508 123 123.



Email access to MYOB technical support—email a concise and accurate description of your
technical issue to the MYOB Technical Support team. MYOB will usually reply by the next business
day. You can email your enquiry to support@myob.co.nz



Fax access to MYOB technical support—fax a concise and accurate description of your technical
issue to the MYOB Technical Support team. MYOB will usually reply by the next business day. You
can fax your enquiry to 03 983 2610.



Notification of and access to regularly‐updated web‐based MYOB support notes—combine an
up‐to‐date subscription with an up‐to‐date email address to receive notice of the latest software
support information online.

Support notes You can access a wide range of technical support notes at myobnz.custhelp.com
Send us your feedback We welcome your suggestions for improvements and changes to
RetailManager. Go to myob.com/ideas and complete the online form, or go to the Help menu and click
Send Product Suggestions.
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MYOB training
MYOB RetailManager Professional MYOB RetailManager Professionals provide independent on‐site
assistance with MYOB RetailManager and associated products and services, including:


Retail business systems needs and analysis



RetailManager installation, setup and implementation



Point‐of‐sale hardware and peripherals solutions



On‐site training and support for RetailManager



RetailManager database maintenance



Integration with MYOB business management software.

As independent businesses, MYOB RetailManager Professionals offer a range of services.
For more information or a list of MYOB RetailManager Professionals, visit myob.co.nz and click
Partners.
MYOB Training and MYOB Approved Training Providers Want to know more about the features in
RetailManager and how they can improve the way you run your retail business?
The MYOB RetailManager course has been designed for those who want to learn more about how
RetailManager can improve their retail business profitability.
To get the most out of RetailManager, it’s crucial that the system is set up correctly from the start. It’s
also important to be aware of the many RetailManager system features that can contribute to
improving your store’s sales performance.
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